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About EndNote 

EndNote Online is a useful bibliographic tool, helping you to keep track of the 

books, journals and other sources that you have used. It helps you to cite and 

create bibliographies, in the referencing style that your department requires. It is 

quite different to the desktop version of the EndNote programme. 

If you need further help, the library EndNote web pages 

https://www.bradford.ac.uk/library/find-out-about/endnote/ and the on-screen 

Help menu should be able to help you. 

Important Note: When using databases to enter references into EndNote you may 

see the following terms used EndNote Online, EndNote Web and simply 

EndNote. If you are asked to choose between these terms always choose either 

EndNote Online or EndNote Web. 

Setting up an account with EndNote Online 

To get access to the full version of EndNote Online you need to register on 

campus or follow the off campus instructions below. If you have registered off 

campus without following these instructions logging in from campus should give 

you full access. 

On-campus 

1. From the library EndNote web pages 

(https://www.bradford.ac.uk/library/find-out-about/endnote/), under the 

heading EndNote Online, click on the link to the EndNote Online website, or 

go direct to https://www.myEndNoteWeb.com. 

2. Click on Sign up for an account and fill in the web form using your email 

address as username and create a password (note that your password must 

be at least 8 characters and contain a letter, number and a symbol). 

Off-campus  

1. Go to Web of Science (https://wok.mimas.ac.uk). 

2. Click the purple “click here to access” button. 

3. Choose Institutional Login (Shibboleth). 

4. From the dropdown list select UK Federation. 

5. Type Bradford in the search box and select University of Bradford from the 

list when you see the login screen log in with your UoB username and 

password. 

6. On the right hand side of the screen, click the Register option. Register, 

using your Bradford email address. Complete the registration form and 

https://www.bradford.ac.uk/library/find-out-about/endnote/
https://www.myendnoteweb.com/
https://wok.mimas.ac.uk/
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choose a password (note that your password must be at least 8 characters 

and contain a letter, number and a symbol). 

7. Click the Submit Registration button and then Continue. 

8. Choose the link to My EndNote Web near the top of the screen. Agree to the 

terms and conditions. 

Once you have set up the account, check for the confirmation email (check your 

junk or clutter folder too) and click on the link. Then go to 

https://www.myendnoteweb.com to log in. 

If you forget your password, there is a forgotten passwords link from the 

EndNote login page. 

Creating a Group 

Start by creating a group for your references.  It is a good idea to create one 

group for all your references for a particular project or topic – you could call it 

“dissertation” etc. To create a group click on the Organize tab. Click on 

Manage my groups (you may find your browser tries to block the scripted 

window pop up – if so right-click on the bar at the top of your browser window 

to allow it) In the pop up box type a name for your group and press OK. 

Setting up your computer to work with EndNote 

Online 

Download the Plugins 

1. The plug-ins can be found by clicking on the Downloads tab at the top of 

the screen. 

2. Choose the relevant download for your operating system.  

3. You will need to close all MSOffice programs to load the EndNote on the 

web plug-in. 

4. Once the download is complete, double click on the icon to install the 

program (Mac users will need to open from the Applications folder). 

5. The plug-in ensures your computer identifies what to do with references 

you download and also installs the ‘cite while you write’ tab into Word. 

Your references 

Manually input a reference 

1. Under the Collect tab, select New Reference.  

https://www.myendnoteweb.com/
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2. Select your Reference Type from the drop-down menu. You will most 

probably want Book, Book Section, Website or Journal Article, but there are 

also other options. Fill in the relevant fields with the information you have, 

i.e. author, title and so on. Enter authors’ names in the format Surname, 

First Name e.g. Smith, Delia or Banks, J O, if you have more than one 

author separate with a semi-colon (;). If the author is an organisation put a 

comma at the end of the name i.e.: World Bank, 

3. The Research Notes field towards the bottom of the list allows you to add 

notes about your reading. This is a searchable field. 

4. When you have finished entering your reference, either choose a group to 

add your reference to, or to have the reference added to the “unfiled” folder, 

click on Save and then “back to top”. 

5. To preview your references, see the section on creating a subject 

bibliography at the end of this handout. 

Change a reference 

1. Select the reference you want to edit and click on the title. 

2. Click on the text you want to edit, and the edit box will appear. 

3. When you have finished, just click on the Save at the top of the screen to 

save changes, or Return to list to return to your list of references.   

Export references from Summon® 

1. Run your search on Summon 

https://bradford.summon.serialssolutions.com. 

2. Add your results to a folder by clicking on the folder icon (to the right of the 

results). 

3. Click on the temporary folder (at the top of the screen). 

4. Select Export To… and select EndNote from the drop-down list. 

5. The reference should be added to your unfiled group.  

6. It is a good idea to check the references for inaccurate information, and 

then move them from unfiled to a group. Click on the tick boxes next to the 

references you want to move, and select the group name you wish to move 

them to from the drop down list of groups. 

Export references from databases: Web of Science™ 

EndNote Web and Web of Science work seamlessly together as they are both 

provided by the same supplier. 

1. Run your search in Web of Science. 

2. Export results either individually using the Save to EndNote Online 

button, or you can create a marked list, and export all your results directly 

to EndNote Online by clicking on the Marked List button at the top of the 

screen.   

https://bradford.summon.serialssolutions.com/
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3. If you wish to include the abstract in your record you need to select your 

records and add to your marked list. View your marked list and check the 

“abstract” box, to include the abstract in the download.   

4. Your references will be saved into your [Unfiled] group. Open the [Unfiled] 

group by clicking on the group name under My References. 

Export references from other databases 

You can also export references from most other databases. Select the EndNote 

Online, EndNote Web or RIS export option. Save the file to your computer. 

From EndNote Online choose Collect and Import References. 

• From Choose File browse to select the file you want to import.  

• From Import option select RefMan RIS. 

• Under To: choose a folder to add the records to – if not using folders select 

[unfiled]. 

• If you are using a computer with only EndNote Online installed you should 

be taken directly to EndNote Online.  

• If you have the EndNote desktop software installed a popup asks whether 

you want to save the records to EndNote or EndNote Online. Select EndNote 

Online. 

If you have any difficulties please contact your subject librarian. 

Exporting references from Google Scholar 

1. When you do your search in Google Scholar you should get a Cite link under 

each result. Click the Cite link. 

2. In the pop up box that appears click the RefMan option (NOT the EndNote 

option). 

3. Your references will be imported into your EndNote Online library. NB: The 

quality of the reference is dependent on the metadata from Google, check 

your references for any missing information. 

“Capture” of webpages etc. 

The plug-in to your browser (Internet Explorer and Firefox only) also has a 

“capture” function which pulls out details from some webpages (generally those 

with an API) and automatically creates references for your EndNote library. Try this 

with Amazon https://www.amazon.co.uk.  

This will also work for some websites but varies depending on the quality of the 

information (metadata) the website has about itself, so do check the resulting 

captures and add any additional information you require. 

https://www.amazon.co.uk/
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Finding the full text of an article 

1. Go to your EndNote Online. Click on the SFX button beneath the reference. 

Where access is available to an article or resource from the library catalogue 

clicking SFX should give you a link saying “Full text is available via…” Click 

on this link to go to the article. 

2. For some other references imported from databases you are given the 

option to refer back to the original item record.  Where this appears click on 

it, and you should be taken back to the original database record. 

Attaching files to your records 

1. You can attach the full text of articles or other documents to your records in 

EndNote.  

2. Click on the paperclip icon for each record. 

3. Browse for the file to attach. 

4. Where records have files attached the paperclip turns slightly blue. 

Removing duplicate records 

Sometimes when you are searching multiple databases you may import duplicate 

references. To remove duplicate references: 

1. Select the Organize tab. 

2. Select Find Duplicates. 

3. The duplicate records are automatically selected. 

4. Click Delete. 

Sharing folders with others 

You can share a group of references with other students. This could be useful for 

group work. It can also be shared with colleagues from other institutions as long 

as they have an EndNote Web account. 

1. Select the Organize tab. 

2. Select the group that you would like to share, click manage sharing. 

3. Add the email address(es) of the people you wish to share your references 

with (note that they will need to set up an EndNote web account). 

4. You can grant read only or read/write access. 

Viewing other groups 

1. Select the Organize tab. 

2. Select Others’ Groups – if nothing is listed you have not been added to a 

group. 

3. Click on Apply. 
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You should now be able to see a heading for each group you are sharing in 

your references. 

Create your bibliography with EndNote on the 

Web 

EndNote online can create your bibliography for you, either as a file for you to 

open, or as part of a file you are working on. You can use EndNote online to 

create links between the text you have entered in a Word document and your 

EndNote references, and create your bibliography as a part of that document.  

Finding and Inserting Citations as you write your essay 

(Cite While You Write) 

1. Open your Word document.  

2. Click on the Down arrow just next to Style. Rather than selecting directly 

from the drop-down menu of styles you must choose: Select another style 

at the top of the drop-down list and a dialog will appear containing details 

of all styles (the first list only goes as far as styles beginning with D!). 

 

3. Open your Word document and position the cursor at the location where 

you would like the citation. (Make sure that you are in Normal view, 

otherwise some functions may not be available. Simply go to View and 

select Normal). You might also want to create a heading for a bibliography 

at the end of your document.  

4. Click Find Citations. The Find Citation(s) search box will appear.  

5. Enter a search term in the Search field to find the reference or references to 

insert.  

• The search will search your entire EndNote Web, including all fields of 

all references and all groups.  

• To search for a specific phrase, such as a title, enclose the phrase in 

double quotes.  

• Using a space between terms acts as an OR operator and returns 

references containing any of the words.  

6. Click the Search button.  
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7. Select the reference. To insert multiple references in one citation, click each 

reference while holding the Ctrl key.  

8. Click the Insert button.  

An alternate way of including references is to enter the author family name and 

date in curly brackets, {name, date}, at the relevant point in your text. Then click 

on update citations and bibliography, this should find your citations in the text 

and pull in the references from your EndNote Web library (creating the 

bibliography at the end). 

Editing citations 

If you want to enter specific page references into the text in your Word document, 

e.g. (Jones, 2001, p.21) 

1. In the Word document, click on the citation to edit to highlight it. 

2. Click on the Edit Citation(s) button in the EndNote Web toolbar. Or if using 

a Mac, select EndNote Web from the Tools menu, then Edit Citation(s). An 

Edit Citation(s) window will appear.  

3. Select the appropriate edit option(s). The options available are:  

• Exclude author – Removes the author’s name in the selected citation. 

Useful if you want to include the author name in the sense of the 

sentence, i.e.: According to Smith (2015), the largest change was….  

• Exclude year - Removes the Year in the citation in the selected citation.  

• Prefix – Adds the prefix entered in the Prefix field to the citation. Use 

this where you are referring to the work of one author that has been 

cited by another ie: Darwin, 1859 cited in Alberts, 2013. The text in 

bold you would add manually to the Prefix field
1

. 

• Suffix – Adds the suffix entered in the Prefix field to the citation. 

• Pages – Adds the page numbers in the citation for a direct quotation. 

Format / Reformat your Bibliography  

Once all citations have been entered, a bibliography will have been created at the 

end of your Word document. You will need to format the bibliography in the style 

recommended by your department. For many this will be the Harvard (Brad) style. 

1. Choose your output style from the drop-down menu. (i.e. Harvard (Brad)) 

First you must go to: Select another style at the top of the drop-down list 

and a popup will appear containing details of all styles rather than the 

shorter list which initially displays. 

                                       
1

 Not all referencing styles use this as a way to cite authors referred to in other works. Check with 

your Department. 
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2. Click on Update Citations and Bibliography. 

Emailing or submitting your word document to Turnitin 

To send the document electronically, or Submit via Turnitin, you need to remove 

the EndNote formatting. Select: Convert Citations and Bibliography and convert 

to plain text. (MacWord users it is Remove Field Codes). 

A message will appear warning that the file will be saved as a new document, 

leaving the original unchanged. The original will still be linked to EndNote, and 

will still be editable. The new document should be saved separately. 

Not using MS Word on Windows? 

Word for Mac users 

1. Download the Plug-in for Mac from the Downloads tab in EndNote. 

2. When the file has downloaded, run from the Applications folder to complete 

the installation. 

3. Once the toolbar has installed it may default to the desktop version of 

EndNote (EndNote X7 etc.). If it does, go to the tab and select Preferences > 

Application and change the default to EndNote online. 

4. If EndNote doesn’t appear as a separate tab or toolbar, try the Tools menu. 

5. To change your reference style in Word for Mac (to Numbered or Harvard 

(Brad) etc.) select Edit and manage citations, choose the cog wheel, then 

either Format Bibliography OR Configure Bibliography (depending on 

your version of Word). 

Users of other Word processors (Open Office etc.) 

If you are using another word processor (Open Office, Pages on a Mac etc.) you 

can use the Format Paper option, to do this you need to enter the citations into 

the text in the format {name, date} in curly brackets regardless of the referencing 

style you are ultimately using, and EndNote Web will match those to items in your 

EndNote folders.  For more information on how to do this see the Format Paper 

section of the Help screens. 
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Subject bibliographies 

This feature allows you to create a bibliography without having to enter citations 

into the text of your Word document. This will create a bibliography of your whole 

folder.  You can sort it by the criteria you select, e.g. by author or by keyword. 

1. From the EndNote Webpage, click on the Format tab and select 

Bibliography. 

2. Select the group of references you want to include. 

3. Select the bibliography output style you want. (If no styles display you need 

to choose a style as your favourite, by clicking on Output Styles and adding 

your chosen style to your favourites). 

4. Next choose the file type you want the output to be, RTF creates a Word 

readable file.  The other options are HTML or TXT. 

5. Now either save the file, email or preview and print the file.  If you save the 

file you can open it in Word and it should display your references in your 

chosen format.  

Moving references from EndNote to EndNote 

online and back again 

This is done from within the EndNote desktop program, which is available on the 

campus PCs. In Edit > Preferences add your EndNote online web account details to 

sync with, the sync will then happen automatically! 

Further help 

If you need further help and advice please contact your subject librarian 

(https://www.bradford.ac.uk/library/about-us/contact-us/) or email 

library@bradford.ac.uk. 
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